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l Manage support contracts
l Look up Micro Focus support contacts
l Review information about available services
l Enter into discussions with other software customers
l Research and register for software training

Most of the support areas require you to register as a Passport user and sign in. Many also require a support
contract.

To register for a Passport ID, go to https://cf.passport.softwaregrp.com/hppcf/login.do.

To find more information about access levels, go to
https://softwaresupport.hpe.com/web/softwaresupport/access-levels.

To check for recent updates or to verify that you are using the most recent edition of a document, contact
your Client Director.
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Chapter 1: Assertion Editor Guide
Welcome to theAssertion Editor User Guide. This guide explains how to use Assertion Editor as part of Micro
Focus Cloud Assessment (Cloud Assessment).

This guide contains the following chapters:

l Assertion Editor, on page 8
Provides an overview of themain features of Assertion Editor.

l Getting Started, on page 14
Describes the installation of themain features, and shows you how to create an assertion project in
Assertion Editor.

l Managing Assertions, on page 20
Explains how to create, download, edit, and compare assertions using Assertion Editor.

l Validating and Publishing Assertions, on page 27
Shows how to test, publish, and resolve conflicts in assertions using Assertion Editor.

l Deploying Assertions, on page 29
Shows how to build an Assertion extension project using Assertion Editor.

l Customizing Assertions, on page 33
Explains how to customize the source type and add PM extensions in Assertion Editor.

l Java Assertion Demo, on page 34
Demonstrates the creation of a custom assertion validator and its use with Assertion Editor andMicro
Focus Cloud Assessment.

l Dialog Box Reference, on page 38
Dialog boxes reference.

l Assertion Document Details, on page 42
Assertion document reference.

l Integrating XQuery Function Libraries, on page 53
Integrating custom XQuery libraries with Assertion Editor.
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Chapter 2: Assertion Editor
Micro Focus Cloud Assessment includes Assertion Editor, a set of features for use with the Policy Manager
component of Micro Focus Cloud Assessment. Assertion Editor enables you to create, edit, and delete
assertions on any number of Policy Manager servers. In addition, you can use Assertion Editor to test an
assertion, validating the assertion against a source document.

This chapter introduces Assertion Editor in the following sections:

l Overview, below
l User Interface, on the next page

Cloud Assessment Workbench Suite
Cloud Assessment Workbench is a suite of editor tools enabling you to customize your deployment of Cloud
Assessment.

Cloud Assessment Workbench consists of the following editor tools, distributed as a single Eclipse
development platform:

l Customization Editor
Customizes the underlying System DataModel (SDM) within Micro Focus Cloud Assessment.

l Taxonomy Editor
Customizes the taxonomies used to categorize artifacts in Micro Focus Cloud Assessment.

l Assertion Editor
Customizes the conditions applied by your business policies within Micro Focus Cloud Assessment.

l Report Editor
Customizes report definitions for use with Micro Focus Cloud Assessment.

Overview
Assertions are the building blocks of policy. Each assertion checks a single condition of a policy, returning a
true or false result. In Policy Manager, one or more assertions are collected together to form a technical
policy. The technical policy is a set of assertions that fulfills a management requirement.

Micro Focus Cloud Assessment provides tools to test whether sources comply with the relevant policies.

Tomeet management requirements, a technical policy often needs a new assertion. Changing requirements
can also result in existing assertions becoming out of date. Assertion Editor is a tool, built on the widely used
Eclipse IDE, to simplify assertion creation and editing.

Assertion Editor makes working with assertions easy.

Use Assertion Editor to do the following:

1. Create an assertion project.
For details, see the following sections:
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l Creating an Assertion Project File, on page 16
l Downloading and Importing Assertions, on page 17

2. Create and manage assertions.
For details, see the following sections:
l Creating Assertions, on page 20
l Editing Assertions, on page 20
l Deleting Assertions, on page 25
l Comparing Assertion Versions, on page 26

3. Validate assertions before publishing.
For details, see Testing Assertions, on page 27.

4. Deploy assertions and manage conflicts.
For details, see the following sections:
l Publishing Assertions, on page 28
l Resolving Conflicts, on page 28

5. Customize assertions for use with Policy Manager.
For details, see Customizing Assertions, on page 33.

User Interface
The default perspective is split into a number of sections with menu options across the top. , as shown
in the following screenshot.

Screenshot: Assertion Editor UI

The platform perspective consists of the following views:

l Project Explorer
The tree view of your assertion projects. For details, see Project Explorer, below.

l Server Explorer
The view listingMicro Focus Cloud Assessment server connections toMicro Focus Cloud
Assessment Workbench. For details, see Server Explorer.

l Editor
The view showing the components of the assertion. For details, see Editor View, on page 12.

Project Explorer
The Project Explorer contains a hierarchical list of projects, the assertions in each project, and the
validation definitions in each assertion.

Assertion Editor
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Screenshot: Project Explorer

The Project Explorer contains additional context menu options enabling you to interact with a running
Micro Focus Cloud Assessment server. Right-click the project name or a particular assertion, and
select Cloud Assessment to view the options listed in the following tables:

Option Function

Download
Assertions

Import Assertions fromMicro Focus Cloud Assessment. For details, see Downloading
and Importing Assertions, on page 17.

Upload to
Server

Export assertions to the default Micro Focus Cloud Assessment server. For details,
see Publishing Assertions, on page 28.

Update
from
Server

Update assertions fromMicro Focus Cloud Assessment. For details, see Editing
Assertions, on page 20.

Remove
from
Server

Delete assertions fromMicro Focus Cloud Assessment. For details, see Deleting
Assertions, on page 25.

Upload To
Other
Server

Export assertions to a specifiedMicro Focus Cloud Assessment server.

Build
Extension

Create an assertion extension for Micro Focus Cloud Assessment containing all the
assertions in your project. For details, see Building an Assertion Extension, on page 29.

Project Context Menu Options

Option Function

Upload to
Server

Export an assertion to the default Micro Focus Cloud Assessment server. For details,
see Publishing Assertions, on page 28.

Assertion Context Menu Options

Assertion Editor
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Option Function

Update
from
Server

Update assertions fromMicro Focus Cloud Assessment. For details, see Editing
Assertions, on page 20.

Remove
from
Server

Delete the assertion fromMicro Focus Cloud Assessment. For details, see Deleting
Assertions, on page 25.

Upload To
Other
Server

Export an assertion to a specifiedMicro Focus Cloud Assessment server.

Build
Extension

Create an assertion extension for Micro Focus Cloud Assessment containing all the
assertions in your project. For details, see Building an Assertion Extension, on page 29.

Assertion Context Menu Options, continued

Server Explorer
The Server Explorer displays theMicro Focus Cloud Assessment servers connected toMicro Focus
Cloud Assessment Workbench. , as shown the following screenshot. The functionality is shared by all
theMicro Focus Cloud Assessment Workbench editors.

Screenshot: Server Explorer View

Right-click a server in the Server Explorer to open the context menu described in the following table.

Option Function

New Server Add a server for downloading assertions and taxonomies (Assertion Editor,
Taxonomy Editor, and Customization Editor).

Remove
Server

Delete a server from the Server Explorer.

Download
Taxonomy

Download a taxonomy from a server (Taxonomy Editor and Customization Editor).

Server Explorer Context Menu Options

Assertion Editor
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Option Function

Download
Assertion

Download assertions from a platform server (Assertion Editor).

Download
Report

Download reports from a reporting server (Report Editor).

Properties View and edit the server name, URL, username, and password.

Server Explorer Context Menu Options, continued

Editor View
The Editor view is themain feature of the Assertion Editor UI.

The pane is split into the following tabs:

l Overview Tab
TheOverview tab shows the components of the assertion.

The tab is divided into the following areas:
o General Information

Name of the assertion and its description.
o Implementation

List of implementations of validation logic and the artifact types to which they apply.
o Reference Template

Element used to reference this assertion from aWS-Policy document.

Assertion Editor
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l Implementation Tab
The Implementation tab includes a list of implementations.

Highlighting an implementation opens the XQuery Definition Editor in the window beneath. For
details, seeWriting XQuery Definitions, on page 22.

l Source Tab
The Source tab is an XML editor for editing the assertion.

Assertion Editor
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Chapter 3: Getting Started
This chapter describes the prerequisites for working with assertions in Assertion Editor. It contains the
following sections:

l Installing Cloud Assessment Workbench, below
l SSLConfiguration, on page 16
l Creating an Assertion Project File, on page 16
l Downloading and Importing Assertions, on page 17
l Assertion Editor Notes, on page 18

Installing Cloud Assessment Workbench
Cloud Assessment is an Eclipse development platform distributed as a zip file, microfocus-
cloudassessment-workbench-1.01-win64.zip.

NOTE:
Cloud Assessment requires Java SE Development Kit (JDK) 1.8.0 (64 bit version only) or higher. You
must include the path to this version of the JDK in the JAVA_HOME environment variable.

(missing or bad snippet)
To Start Cloud Assessment:

l ExecuteWB_HOME/workbench/start.exe.
The first time you start Micro Focus Cloud Assessment Workbench, the welcome screen opens.

Screenshot: Workbench Welcome Screen

Select one of the options to open one of the editor tools, start a new editing project, or view the documentation
set.

You can return to the welcome screen from any of the editor tools by selectingHelp > Welcome from the
menu options.
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TIP:
By default, Micro Focus Cloud Assessment Workbench runs in 'normal' mode which prevents
users from uploading system taxonomies (IDs start with
uddi:systinet.com:soa:model:taxonomies) and the Report Editor .rptlibrary file to Micro
Focus Cloud Assessment servers. If you need to work with system taxonomies or want to
upload the .rptlibrary file you can switchMicro Focus Cloud Assessment Workbench into
'admin' mode.

CAUTION:
Be extremely careful when working with system taxonomies, Micro Focus Cloud Assessment
uses some hard-coded values from system taxonomies. Changing or removing themmay
cause errors.

To Switch Micro Focus Cloud Assessment Workbench to Admin Mode

1. Open WB_HOME/configuration/config.ini with a text editor.
2. Add mode=admin to config.ini.
3. Restart Micro Focus Cloud Assessment Workbench.

TIP:
Micro Focus Cloud Assessment is memory-intensive. If you experience performance issues,
Micro Focus recommends increasing thememory allocation.

To increase the memory allocation for Micro Focus Cloud Assessment:

1. Open WB_HOME/workbench/start.ini for editing.
2. Set these new values:

l -Xms128m

l -Xmx1024m

3. Save your changes.
4. Restart Micro Focus Cloud Assessment Workbench.

TIP:
Micro Focus Cloud Assessment downloads fromMicro Focus Cloud Assessment may time
out. If you experience issues, Micro Focus recommends increasing the time out.

To increase the time out for Micro Focus Cloud Assessment:

1. Open WB_HOME/workbench/start.ini (or eclipse.ini for stand-alone installation) for editing.
2. Set the new value:

-Dorg.cloudassessment.platform.rest.Client.timeout=200000

The value is in milliseconds with a default value of 120000 (2minutes).
3. Save your changes.
4. Restart Micro Focus Cloud Assessment Workbench.

TIP:
Workbenchmay fail to store saved credentials of servers. In such cases, Micro Focus
recommends clearing the secure storage.

To reset the secure storage for Cloud Assessment server credentials:

Assertion Editor
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1. In Cloud Assessment, go toWindows > Preferences > General > Security > Security
Storage > Contents tab.

2. Click root nodeDefault Secure Storage and then click Delete button.

3. Restart theWorkbench.

SSL Configuration
By default, Micro Focus Cloud Assessment Workbench trusts all Micro Focus Cloud Assessment
server certificates. Youmay want Micro Focus Cloud Assessment Workbench to verify Micro Focus
Cloud Assessment certificates.

To Verify Micro Focus Cloud Assessment Server Certificates:

l Add the following options to WB_HOME/workbench/start.ini:

-Dcom.microfocus.cloudassessment.security.ssl.verifyCert=true
-Djavax.net.ssl.trustStore=USER_TRUSTSTORE
-Djavax.net.ssl.trustStorePassword=TRUSTSTORE_PASS
-Djavax.net.ssl.trustStoreType=TRUSTSTORE_FORMAT

If Micro Focus Cloud Assessment is configured for 2-way SSL, youmust provideMicro Focus Cloud
Assessment Workbench certificates toMicro Focus Cloud Assessment.

To Provide Micro Focus Cloud Assessment Workbench Client Certificates to Micro Focus
Cloud Assessment:

l Add the following options to WB_HOME/workbench/start.ini:

-Djavax.net.ssl.keyStore=USER_KEYSTORE
-Djavax.net.ssl.keyStorePassword=KEYSTORE_PASS
-Djavax.net.ssl.keyStoreType=KEYSTORE_FORMAT

Creating an Assertion Project File
Towork with assertions, you need an Assertion Project. You can create any number of Assertion
Projects to help organize your work.

To Create an Assertion Project:

1. Do one of the following:
l In theMicro Focus Cloud Assessment WorkbenchWelcome page, click Create Assertion
Project.

l Click New to open the Select aWizard window, and select Cloud Assessment >
Assertion Project.

l From themenu, select File > New > Assertion Project.
l Press Alt+Shift+N, and then press R, to open the Select aWizard window. Then select Cloud
Assessment > Assertion Project.

The New Assertion Project dialog box opens.

Assertion Editor
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2. In the New Assertion Project dialog box, enter the following parameters:

Parameter Definition

Project Name The name of your assertion project.

Namespace The namespace to apply to all assertions in the project.

Create from
Existing
Extension

Select this option if you want to create a new project from a previous assertion
extension. If selected, input the path or browse for the location of the assertion
extension.

Use Default
Location

If selected, Assertion Editor stores the project in your default workspace. If
unselected, input the path or browse for an alternative workspace.

3. Click Next to select or create a server.

NOTE:
If no servers are currently defined, the dialog box continues to Step 5.

4. Do one of the following:
l Select Create a New Server, and click Next.
Continue to Step 5.

l Select Use an Existing Server, select the server from the list and input its credentials, and
then click Next.
Continue to Step 6.

5. In the New Server dialog box, add the required parameters, and then click Next.
6. Select the assertions to download from the server.
7. Select Download All Taxonomies to import taxonomies from Cloud Assessment to make them

available for use as assertion parameters.
8. Click Finish.

Downloading and Importing Assertions
Using Assertion Editor, you can download assertions from anMicro Focus Cloud Assessment server
to edit or test them.

You can download assertions in one of two ways:

l When you create a project, as described in Creating an Assertion Project File, on the previous page.
l From your local file system, at a later date.

CAUTION:
If you import assertions containingmanual validation, Assertion Editor highlights themanual
validation as an error with amessage instructing you to remove it from the assertion.

To Download Assertions:

1. Right-click the server containing the assertions you need in Server Explorer to open its context
menu, and select Download Assertions.

Assertion Editor
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The Download Assertion dialog box is displayed.
2. Select the assertions to download, and click Next.

The Choose Location dialog box is displayed.
3. Select the project to add the assertions to, and click Finish.
To Import Assertions from a Local File:

1. Right-click at Assertion project name in Project Explorer to open its context menu, and select
Import > Assertions.
The Import Assertion dialog box is displayed.

2. Select the assertions to import, and click Next.
The Choose Location dialog box is displayed.

3. Select the project to add the assertions to, and click Finish.
The assertions are imported to your project.

Assertion Editor Notes
NOTE:
In case you useWorkbench to implement Javascript assertions, the built-in Javascript editor
might throw some unexpected errors.

To resolve this, uncheck Other JavaScript Proposals inWindow > Preferences> JavaScript >
Editor > Content Assist > Advanced.

Assertion Editor
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Chapter 4: Managing Assertions
This chapter explains how to work with assertions, as detailed in the following sections:

l Creating Assertions, below
l Editing Assertions, below
l Deleting Assertions, on page 25
l Comparing Assertion Versions, on page 26

Creating Assertions
In Creating an Assertion Project File, on page 16, you created an Assertion Project and looked at how to
download and import assertions. The following section explains how to create new assertions.

To Create a New Assertion:

1. Do one of the following:

l Click New to open the New: Select aWizard dialog. ExpandMicro Focus Cloud Assessment
> Assertion and click Next.

l Select File > New > Assertion.
l Press Alt+Shift+N to open the context menu, and select Assertion.
The New Assertion wizard is displayed.

2. In the New Assertion wizard, enter the required parameters.
3. Click Finish to create the assertion.
4. Double-click the assertion in Project Explorer to open it in the Editor, and do the following:

l Add an implementation, as described in Adding and Deleting Implementations, on the next page.
l Test the assertion, as described in Testing Assertions, on page 27.
l Publish the assertion, as described in Publishing Assertions, on page 28.

Editing Assertions
The heart of Assertion Editor's functionality is the ability to edit assertions. To edit an assertion, youmust
have a local copy.

CAUTION:
If you are editing an assertion that also exists on a server, youmust update your local copy before
editing it. Editing a local assertion before updating it from the server can result in a revision conflict.
Assertion Editor warns you if this is the case. For details, see Resolving Conflicts, on page 28.

To Update an Assertion from the Server:

1. Right-click the assertion in Project Explorer to open its context menu.
2. Select Cloud Assessment > Update from Server.
Themain functionality of editing assertions is described in the following sections:
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l Editing General Properties, below
l Adding and Deleting Implementations, below
l Writing XPath Definitions, on the next page
l Writing XQuery Definitions, on the next page
l Writing JavaScript Definitions, on page 23
l Editing XQuery Definitions, on page 23
l Editing Reference Templates, on page 25

Editing General Properties
General properties are the name and text description of the assertion. Changing the name in the editor
does not change the file name or reference template local name. These can only be changed in the
General Properties section of the Overview tab of the Assertion Editor View. For details, see Editor
View, on page 12.

Adding and Deleting Implementations
An implementation contains a resource type and the code used to validate that resource type. An
assertionmust contain one or more implementations.

To Add an Implementation:

1. In the Implementation field of the Editor view, click New.
The Define New Implementation wizard opens. For details, see Define New Implementation
Wizard, on page 38.

2. Do one of the following:
l To use a predefined resource type, select Select an Existing Type and select a resource type
from the list. Use filter to find a specific resource type and uncheck Show common types
only to list all available resource types and then click Next.
Skip to Step 4.

l Tomanually define a new resource type, select Define New Type and then click Next.
3. Input a Namespace and Local Name, or click Load from file to use a document in your assertion

project, and then click Next.
4. Select the implementation type from the list and then click Finish.
To Delete an Implementation:

1. Open the Editor view and select theOverview tab.
Implementations in your project are displayed in the Implementation window.

2. To delete an implementation, select it and click Delete.
After adding the implementation, open the Implementation tab of the Editor and edit the XQuery,
JavaScript or XPath definitions tomeet your needs. For instructions, seeWriting XPath Definitions, on
the next page orWriting XQuery Definitions, on the next page orWriting JavaScript Definitions, on
page 23.
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Writing XPath Definitions
After creating an implementation that uses an XPath validation handler, as described in Adding and
Deleting Implementations, on the previous page, you need to write the XPath definition.

To Write an XPath Definition:

1. Open the Editor view and select the Implementation tab.
2. Import a sample XML document of the type to which the assertion applies.
3. In the XPath Definition Editor, under Load XML Template, select one of the following links:

l Click From Resource to load a sample XML document from your Assertion Editor project.
l Click From File to load a sample XML document from your local file system.
l Click From URL to load a sample XML document from theWeb.
The XML document appears in the XML Template tab.

To Add an XPath Expression:

1. Right-click the relevant line in the sample XML document to open its context menu.
2. Select Generate XPath Expression.

The XPath expression appears in the XPath Definition Editor field.

NOTE:
You can have only one XPath expression for each implementation. An artifact passes
validation if at least one XML nodematches the XPath expression.

3. Modify the XPath expression in the XPath Definition Editor, if necessary.

4. If the XPath contains any unresolved namespace prefixes, an unresolved warning appears.
l If you receive a warning, go to Step 5.
l If you do not receive a warning, go to Step 8.

5. Click the unresolved prefix link.
TheManage prefix and namespace pane opens.

6. Define the namespace of the prefix, as follows:
l To add a namespace, click Add, and then enter the required parameters.
l To delete a namespace, select it and click Remove.

7. Click OK.
8. To test the XPath expression, click Test Expression.

The results of the test appear in the Test Results tab of the XPath Expression Editor.
For more information, see XPath Assertions, on page 49.

Writing XQuery Definitions
Assertion Editor incorporates syntax highlighting for writing and editing XQueries.

To Write an XQuery Definiton:

Assertion Editor
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1. Open the assertion in the Editor view, open the Implementation tab and click New.
The Define New Implementation dialog box opens, as shown in Define New Implementation
Wizard, on page 38.

2. To use a predefined source type:
l Select the source type you need from the list and click Next.
l In the Implementation type, select XQuery from the list, and click OK.

3. Tomanually define a source type:
l Select the Define new type.
l Enter the required parameters and click Next.
l In the Implementation type, select XQuery from the drop-down list, and click OK.
The XQuery Definition opens in the Editor view.

4. Edit the XQuery Definition, as described in Editing XQuery Definitions, below, and click Test
Assertion.
If the assertion passes validation, you can now publish the assertion. For details, see Publishing
Assertions, on page 28.
If the assertion does not pass validation, you can resolve any problems. For details, see
Resolving Conflicts, on page 28.

For more information, see XQuery Assertions, on page 50.

Writing JavaScript Definitions
Towrite JavaScript definition:

1. Open the assertion in Editor view, click the Implementation tab and then click New.
The Define New Implementation dialog box opens, as shown in Define New Implementation
Wizard, on page 38.

2. To use a predefined source type:
l Select the source type you need from the list and click Next.
l In the Implementation type, select JavaScript from the list and click OK.

3. Tomanually define a source type:
l Select the Define new Type.
l Enter the required parameters and click Next.
l In the Implementation type, select JavaScript from the list and click OK.

Editing XQuery Definitions
Assertion Editor also supports external XML editors.

To use an external XQuery editor with Assertion Editor, youmust first add the Saxon extension to the
external editor:

Assertion Editor
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l Folder
WB_HOME/plugins/com.cloudassessment.tools.assertioneditor.lib_version-
number/lib/saxon-extensions/

l Extension
pm-extension-functions.jar

To Edit an XQuery Definition:

1. In Project Explorer, right-click the XQuery to open its context menu, select Open With, and then
select from the following options:
l Text Editor
To edit the XQuery with a plain text editor.

l System Editor
To edit the XQuery with an editor currently used by your system.

l In-place Editor
To edit the XQuery with anOLE editor.

l Default Editor
To edit the XQuery with the default editor provided with Assertion Editor.

l Other
To edit the XQuery with an editor not previously defined.

2. Edit the XQuery as required and save your changes.
Instructions on how to add the Saxon extension to themost popular XML editors are given in the
following procedures:

To Set Up oXygen™ to Edit XQueries:

1. Open or create the XQuery file in oXygen.
2. Click Configure Transformation Scenario to open the Configure Transformation Scenario

wizard.
3. Select Execute XQuery, and click New to open the Edit Scenario pane.
4. In the Transformer field, select Saxon 8B.
5. Click Extensions to open the Extensions dialog box, and click Add to open the Add Extension

dialog box.
6. Type in or browse for the path to pm-extension-functions.jar.
7. Click OK in all wizard panes to save the transformation scenario.
When you open any other XQuery files, youmust always choose this transformation scenario and then
edit the XQuery file to force oXygen to rebuild it.

NOTE:
This procedure was created for oXygen 8.1. Other versions can be used but some details may
differ.

To Set Up Stylus Studio™ to Edit XQueries:

1. Select Tools > Options to open theOptions dialog box.
2. ExpandModule Setting+XQuery > Processor Settings from the treemenu.
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3. In theProcessor drop-down list, select Saxon 9.0.0.2, and then, click theUse as default
processor checkbox.

4. Click OK.
5. Select Project > Set Classpath and add the path to pm-extension-functions.jar.
To Open an XQuery in Stylus Studio™ from Assertion Editor:

1. In the Project Explorer of the Assertion Editor UI, right-click the XQuery.
2. Select Open With > System Editor.

Editing Reference Templates
The referencing template defines the element used to reference an assertion from a Technical Policy
document. The template can include parameters which represent requirements whose specific values
might vary.

To Edit an Assertion's Reference Template:

1. Open theOverview tab in the Editor view.
2. In the Reference Template pane, enter the required parameters.
3. Do one of the following:

l To add a parameter, click New.
l To edit an existing assertion, highlight it, and then click Edit.
The Define Parameter wizard opens.

4. Input a name, description, select if the parameter is optional or required.
5. Do one of the following:

l Select Primitive type and the parameter type from the drop-down list.
l Select Taxonomy and input orBrowse for the relevant taxonomy.

NOTE:
The available taxonomies depend on those imported fromMicro Focus Cloud
Assessment when you created the project.

To Update Taxonomies:
a. Open the context menu for the assertion project and select Properties to open the

Project Properties dialog box.
b. Select Taxonomies to view the list of downloaded taxonomies from the server.
c. Click Download to update the taxonomies in the project.

6. Click OK.
To preview the reference template in a technical policy, click Preview assertion reference to open the
dialog box, and then enter example parameter values.

Deleting Assertions
If an assertion is no longer useful, you can delete it in one of the following ways:

To Delete a Local Copy of an Assertion:
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l Right-click the assertion in Project Explorer to open its context menu, and select Delete.
Deleting a local copy of an assertion does not affect the version on the server.

To Delete an Assertion on a Server:

l Right-click the assertion in Server Explorer to open its context menu, and select Delete Assertion.
Deleting the version of an assertion that is on a server does not affect any local versions.

Alternatively, you can delete an assertion from the server directly from the Project Explorer. This gives
you the option of deleting the local copy at the same time.

To Delete an Assertion from the Server and the Local Copy:

1. Right-click the assertion in Project Explorer to open its context menu, and selectMicro Focus
Cloud Assessment > Remove from Server.

2. When prompted, select one of the following:
l Also delete resources from local file system.
l Do not delete resources on local file system.

Comparing Assertion Versions
Assertion Editor uses the Eclipse Compare function to track version numbers, enabling you to roll back
an assertion to a previous version.

To Compare Versions of an Assertion:

1. Right-click the assertion in Project Explorer to open its context menu, and select Replace with >
Local History.
The Replace with Local History window opens.

NOTE:
Changes to XQuery implementations do not appear in this window. XQueries are held in
separate, stand-alone files so they can be accessed by external XML editors. Use your
editor's revision control feature for XQueries.

2. Compare the versions.
3. Click Replace, if you want to replace the current version with the one to which you are comparing

it.
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Chapter 5: Validating and Publishing
Assertions
This chapter explains how to test assertions and deal with validation conflicts before publishing or exporting
them, as detailed in the following sections:

l Testing Assertions, below
l Resolving Conflicts, on the next page
l Publishing Assertions, on the next page

Testing Assertions
Before publishing an assertion, you can test it.

To Test an Assertion:

1. Double-click the assertion in Project Explorer to open it in the Editor.
2. Click Test Assertion.

The Run Configurations dialog box opens. For details, see Run Configurations Dialog, on page 40.
3. Enter the required parameters, and click Apply to save the parameters, orRevert to roll back the

changes.
4. Click Run.

The test results appear in the Assertion Console view.
To Test a Different Assertion:

1. Click Browse.
The Select Assertion window opens

2. Browse for the required assertion.
3. Click OK.
4. Enter the required parameters, and click Run.
To Select Source Files for Testing an Assertion:

1. Click Add Documents to locate the source file to add,
2. Enter the required parameter values in the Parameters table, and then do one of the following:

l Click Apply.
l Click Revert to use themost recent parameter value.
For information about assertion reference templates, see Editing Reference Templates, on page 25.

3. Click Run.
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Resolving Conflicts
Conflicts occur when there are differences between an updated local copy of an assertion and that on
the server. Assertion Editor notifies you of the conflict, and asks if you want to force the update or
publication.

Forcing an assertion to be updated overwrites any local changes that have beenmade. Forcing an
assertion to be published overwrites any changes that weremade to the version on the server.

The safest way to resolve such conflicts is to either cancel publication or update the assertion.

To Update a Conflicting Assertion:

1. Copy your local version of the assertion to a different location in Project Explorer.
2. Right-click the assertion to open its context menu, and select Cloud Assessment > Update

Assertion.
A conflict warning appears.

3. Click OK to update the assertion.
Assertion Editor overwrites the local copy of the assertion with the version on the server.

Publishing Assertions
After writing, editing, and testing an assertion, you can publish it to anMicro Focus Cloud Assessment
server.

NOTE:
In Project Explorer, assertions that have not been published are indicated by a questionmark
(?). Assertions that have been changed locally since they were last synchronized with the
version on the server are indicated by a right arrow (>).

To Publish an Assertion:

l Right-click the assertion in Project Explorer to open its context menu, and select Cloud
Assessment > Upload to Server.

Assertion Editor connects to the server and attempts to publish the assertion.

To Select a Server that is not in the Project:

1. Right-click the assertion to open its context menu, and select Cloud Assessment > Upload to
Other Server.
The New Server wizard opens.

2. Follow the steps for adding a server, as described in Creating an Assertion Project File, on page
16.

CAUTION:
If changes weremade to the version on the server since you last synchronized, a conflict
warning appears that asks whether you want to force publication. For details on conflict
resolution, see Resolving Conflicts, above.
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Chapter 6: Deploying Assertions
This chapter explains how to deploy a set of assertions as an Extension Project, as detailed in the following
sections:

l Building an Assertion Extension, below
l Applying Extensions , below
l Redeploying the EAR File, on page 32

Building an Assertion Extension
After publishing assertions, you can copy them to an Assertion extension.

NOTE:
In Project Explorer, assertions that have not been published are indicated by a questionmark (?).
Assertions that have been changed locally since they were last synchronized with the version on the
server are indicated by a right arrow (>).

To Build an Assertion Extension:

1. Right-click the assertion project in Project Explorer to open its context menu, and expandCloud
Assessment > Build Extension to open the location browser.

2. Enter a name for the extension project and browse for the location you want to save the project to, and
then click Save.
All assertions from the selected assertion project are copied to the Assertion extension.

Applying Extensions 
You can extend Cloud Assessment by adding libraries or JSPs to the deployed EAR files, by modifying the
datamodel, by configuring the appearance of the UI, and by importing prepackaged data.

Extensions to Cloud Assessment come from the following sources:

l Customization Editor
Typical extensions created by Customization Editor contain modifications to the datamodel and artifact
appearance, and possibly data required by the customization (taxonomies). They may also contain new
web components, whichmay include custom JSP and Java code.
If your extension contains new artifact types, Cloud Assessment does not create default ACLs for them.
Set default ACLs for the new artifact types in Cloud Assessment. using the functionality described in
"How toManage Default Access Rights" in theAdministration Guide.

l Assertion Editor, Report Editor, and Taxonomy Editor
These extensions contain assertion, reporting, and taxonomy data only. They do not involve changes to
the datamodel.

The Setup Tool opens the EAR files, applies the extensions, and then repacks the EAR files.

Apply extensions according to one of the following scenarios:
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l Single-Step Scenario , below
The Setup Tool performs all the processes involved in applying extensions, including any database
alterations, as a single step.

l Decoupled DB Scenario , on the next page
Database SQL scripts are runmanually. The Setup Tool performs the other processes as individual
steps that are executable on demand. This scenario is useful in organizations where the user
applying extensions does not have the right to alter the database, which is done by a database
administrator.

CAUTION:
In some specific circumstances (underscores and numbers in property names), extension
applicationmay fail because Cloud Assessment cannot create short enough database table
names (31 character maximum for most databases).

The error in setup.log resembles the following:

[java] --- Nested Exception ---
[java] java.lang.RuntimeException: cannot reduce length of identifier

'ry_c_es_Artifact02s_c_priEspPty01Group_c_priEspPty01',
rename identifier elements or improve the squeezing algorithm

[java] at com.cloudassessment.platform.rdbms.design.decomposition.naming.impl.
BlizzardNameProviderImpl.getUniqueLimitedLengthName(

BlizzardNameProviderImpl.java:432)
[java] at com.cloudassessment.platform.rdbms.design.decomposition.naming.impl.

BlizzardNameProviderImpl.filterTableName(BlizzardNameProviderImpl.java:374)

If you do not require backward compatibility with these older versions, you can change the table
naming algorithm.
To change the table naming algorithm:

1. Open CloudAssessment_HOME/lib/pl-repository-old.jar#META-
INF/rdbPlatformContext.xml with a text editor.

2. In the rdb-nameProvider bean element, edit the following property element:
<property name="platform250Compatible" value="false"/>

3. Save rdbPlatformContext.xml

CAUTION:
This solution only impacts properties with multiple cardinality. If the problem persists or
you need to preserve backward compatibility, then review the property naming
conventions in your extension.

Single-Step Scenario 
Follow this scenario if you have permission to alter the database used for Cloud Assessment.

To apply extensions to Cloud Assessment in a single step:

1. Make sure that all extensions are in the following directory:
CloudAssessment_HOME/extensions
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The Setup Tool automatically applies all extensions in that directory.
If you are applying extensions to another server, substitute the relevant home directory for
CloudAssessment_HOME

2. Stop the server.
3. Start the Setup Tool by executing the following command:

CloudAssessment_HOME/bin/setup.bat(sh)
4. Select theApply Extensions scenario, and click Next.

The Setup Tool automatically validates the step by connecting to the server, copying the
extensions, andmerging the SDM configuration.

5. Click Next for each of the validation steps and the setup execution.
This process takes some time.

6. Click Finish to end the process.
7. Deploy the EAR file:

The Setup Tool deploys the EAR file automatically.
If you need to deploy the EAR file to JBoss manually, see Redeploying the EAR File, on the next
page.

8. Restart the server.

CAUTION:
Applying an extension that modifies the SDMmodel may drop your full text indices.

CloudAssessment_HOME/log/setup.log contains the following line in these cases:

Could not apply alteration scripts, application will continue with slower DB
drop/create/restore scenario. ... .

In these cases, reapply full text indices. as described in the "Enabling Full Text Search" section
of theMicro Focus Cloud Assessment Installation and Deployment Guide.

Decoupled DB Scenario 
Follow this scenario if the user who applies extensions does not have permission tomodify the
database.

To apply extensions and modify the database separately:

1. Make sure that all extensions are in the following directory:
CloudAssessment_HOME/extensions

The Setup Tool automatically applies all extensions in that directory.
2. Stop the server.
3. Start the Setup Tool by executing the following command:

CloudAssessment_HOME/bin/setup -a.
4. Select theApply Extensions scenario, and click Next.
5. Click Next, to execute the extension application, and exit the Setup Tool.
6. Provide the scripts from CloudAssessment_HOME/sql to the database administrator.
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The database administrator can use all.sql to execute the scripts that drop and recreate the
database schema.

7. Execute the Setup Tool in command-linemode to finish the extension application:
CloudAssessment_HOME/bin/setup -c

8. Redeploy the EAR file:
The Setup Tool deploys the EAR file automatically.
If you need to deploy the EAR file to JBoss manually, see Redeploying the EAR File, below.

Redeploying the EAR File
After using the Setup Tool to apply extensions or updates, youmust redeploy the EAR file to the
application server. For JBoss, you can do this using the Setup Tool.

To Redeploy the EAR file to JBoss:

1. Stop the application server.
2. Start the Setup Tool by executing the following command:

CloudAssessment_HOME/bin/setup.bat(sh)
3. Select theAdvanced scenario, and click Next.
4. Scroll down, select Deployment, and then click Next.

When the Setup Tool validates the existence of the JBoss Deployment folder, click Next.
5. Click Finish to close the Setup Tool.
6. Restart the application server.
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Chapter 7: Customizing Assertions
Assertion Editor incorporates predefined elements that are suitable for most use cases. However, you can
customize certain elements. Customization of assertions is described in the following sections:

l Customizing Source Type, below
l Adding Policy Extensions, below

Customizing Source Type
When you define the implementation of an assertion, you can either select from a list provided by Assertion
Editor, or you can define your own source type.

To Manipulate Source Types:

1. From themenu, selectWindow > Preferences.
The Preferences wizard opens.

2. ExpandCloud Assessment Assertion Editor, and select Source Type.
A table opens displaying source type names, local names, and namespaces.

3. Do one of the following:
l To create a new source type, click Add to open the New Source Type window. Enter the required
parameters, and click OK.

l To edit an existing source type, select it and click Edit to open the Edit Source Type window. Enter
the required parameters, and click OK.

l To delete an existing source type, select it and click Delete.

Adding Policy Extensions
You can extendMicro Focus Cloud Assessment with custom-written validation handlers, in addition to the
XQuery and XPath handlers that are included in the distribution.

To Add a PM Extension to your Project:

1. Right-click the project in Project Explorer to open its context menu, and select Properties.
The Properties for Cloud Assessment wizard opens.

2. Select PM Extensions to open a list of PM extensions in the project.
3. Do one of the following:

l Click Add PM Extension to open the Select Extension window. Select the required extension, and
click OK.

l Click Add External PM Extension to open the Select PM Extension window. Browse for the
required extension, and click OK.

After adding a PM extension to your Assertion Editor project, apply it to all relevant Micro Focus Cloud
Assessment servers with the Setup Tool. For information about the Setup Tool, see the Cloud Assessment
Administrator Guide.
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Chapter 8: Java Assertion Demo
This demo shows how to create and use a custom assertion validator. You will learn how to:

l Create a custom assertion validator.
l Apply a custom assertion validator into Micro Focus Cloud Assessment as an extension.
l Create an assertion in Assertion Editor based on our validator.
l Publish the assertion to the Platform repository.
You can find the demo sources in CloudAssessment_HOME\demos\policymgr\assertionvalidator. It
contains:

l An Eclipse project for developing a custom assertion validator (in the validator folder).
l An Assertion Editor project for developing a sample assertion (in the assertion folder).
l Demo data for testing our assertion validator (in the demodata folder).
The demo is divided into separate procedures, described in the following sections:

l Creating the Assertion Validator, below
l Applying the Validator Extension, on the next page
l Creating and Deploying the Assertion, on page 36
l Testing the Assertion Validator, on page 36

Creating the Assertion Validator
A sample Eclipse project is available in CloudAssessment_
HOME\demos\policymgr\assertionvalidator\validator. This project can be imported into Eclipse as an
existing project. It has the following structure:

l src/

A directory containing the Java sources.
l lib/

A directory containing external libraries used by assertion validator.
l resources/extension.xml

A Policy Manager extension definition file.
l build.xml

An Ant build file to build extension containing the validators.
The src folder contains a sample implementation of an assertion validator:
mycompany.validator.demo.ServiceNameValidator. This validator applies toWSDL documents and
checks whether the name of services defined inWSDL starts with the words "dummy," "test," "sample," or
"example."

The assertion validator class must implement bothmethods of the interface
org.cloudassessment.policy.validation.AssertionValidator:
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l QName getDialect()—Must return a QNamewhich will be used in assertions to invoke this
validator. Our example uses the QName {http://mycompany/validation}
ServiceNameValidator.

l void validate(ValidationListener listener, SourceCollection sources, SourceType
sourceType, ValidatedAssertion[] assertions, ValidationContext context)—This is
the validationmethod which is called when a sourcemust be validated against an assertion using
this validator. Our sample validator parses the XML content of theWSDL document and checks
each service name (under XPath /wsdl:definitions/wsdl:service/@name) to see whether it
starts with the unwanted words or not.

NOTE:
Formore information about the Policy Manager's interfaces see theMicro Focus Cloud
Assessment Javadoc.

To build an extension from your assertion implementation, you need an extension definition file, which
is available at resources/extension.xml. It contains a unique identifier (attribute uri) which identifies
the extension, the extension name (element name), and the list of contained assertion validators
(elements assertion-validator):

<?xml version="1.0"?>
<extension version="1.0" uri="mycompany.ext.demo">

<name>Demo Assertion Validators</name>
<assertion-validator class="mycompany.validator.demo.ServiceNameValidator" />

</extension>

To build the extension you can use Eclipse to start an ANT build using build.xml or use the following
procedure:

To Build an Extension for the Assertion Validator:

1. Change your working directory to CloudAssessment_
HOME\demos\policymgr\assertionvalidator.

2. To get help demo demo.bat or demo.sh.
3. Build the extension with the command demo make.
4. Check the created extension in CloudAssessment_

HOME\demos\policymgr\assertionvalidator\validator\dist\Demos.jar.

CAUTION:
If you want use an Eclipse project for this demo youmust define the EM_CLIENT_LIB classpath
variable in the Eclipse IDE. The EM_CLIENT_LIB variable must point to CloudAssessment_
HOME/client/lib.

Applying the Validator Extension
After you create Demos.jar, apply it to Micro Focus Cloud Assessment as an extension.

To Apply the Extension to Micro Focus Cloud Assessment:

1. Make sure the Cloud Assessment server is not running.
2. Copy CloudAssessment_

HOME\demos\policymgr\assertionvalidator\validator\dist\Demos.jar into
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CloudAssessment_HOME\extensions.
3. Execute CloudAssessment_HOME\bin\setup and select theApply Extensions scenario.
4. Start Cloud Assessment.
For details, see Applying Extensions , on page 29.

Creating and Deploying the Assertion
There is a sample project for Assertion Editor in CloudAssessment_
HOME\demos\policymgr\assertionvalidaton\assertion.

You can use this sample project to create your own assertions. It already contains a demo assertion
named WSDLServiceNameIsNotDummy. Browse this assertion to see that it is applicable toWSDL
Documents and implements the ServiceNameValidator created in Creating the Assertion Validator,
on page 34 (linked through CloudAssessment_
HOME\demos\policymgr\assertionvalidator\validator\dist\Demos.jar).

The XML definition of the assertion is automatically filled out according to the definition in assertion
validator (in themethod getDialect()):

<my:ServiceNameValidator xmlns:my="http://mycompany/validation"
xmlns:pm="http://systinet.com/2005/10/soa/policy"/>

After creating the assertion, deploy it. Or deploy the existing WSDLServiceNameIsNotDummy assertion.

To Publish the Assertion to Micro Focus Cloud Assessment:

1. Open Assertion Editor.
2. Open the File menu and select Import > Existing Projects into Workspace and open the demo

project.
3. In the Server Explorer, open the context menu and define aNew Server pointing to your Micro

Focus Cloud Assessment server.
4. In the Project Explorer, open the Project context menu and select Properties > Cloud

Assessment Server, and select the server you just defined.
5. Publish the demo assertion from the Project Explorer.

Open theWSDLServiceNameIsNotDummy.asr context menu and select Cloud Assessment >
Upload to Server.

For more details, see the Publishing Assertions, on page 28.

Testing the Assertion Validator
In the previous sections you created and deployed an assertion validator and an assertion. The next
step is to use this new assertion in a validation for a business test case. To do this, you need to do the
following inMicro Focus Cloud Assessment:

l Publish aWSDL containing a service element where the name attribute starts with Test. For details,
see "How to Publish Content" in the Cloud Assessment User Guide.

l Create a Technical Policy applicable toWSDLs and add the WSDLServiceNameIsNotDummy
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assertion to it. For details, see "How toManage Technical Policies" in the Cloud Assessment
Administration Guide.

l Create a Policy Report using artifact type, WSDL, and the new technical policy. For details, see "How
to Create Policy Reports" in the Cloud Assessment User Guide.

l Execute the policy report and review the result. TheWSDLwith the service name attribute Test
must fail while all others should pass. For details, see "How to Review Policy Reports" in the Cloud
Assessment User Guide.
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Appendix A: Dialog Box Reference
Each Assertion Editor input dialog is described in the following sections:

l Define New ImplementationWizard, below
l RunConfigurations Dialog, on page 40

Define New Implementation Wizard
The Define New ImplementationWizard enables you to add a new implementation of an assertion either from
an existing resource type or by adding a new one.

The wizard contains the following steps.

1. Enter general parameters to define the new implementation.
Screenshot: Define New Implementation: Select Resource Type

Parameter Definition

Define New Type Select this check-box tomanually define the resource type you want to
use.
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Parameter Definition

Select an Existing Type Select a predefined resource type from the drop-downmenu.

Filter Text Use the input to reduce the list of resource types.

Show Common Types
only

De-select to show the full list of resource types.

2. If you are defining a new implementation resource type, youmust specify the namespace and
local name.
Screenshot: Define New Implementation: New Type

Parameter Definition

Namespace Namespace of the source type.

Local Name The local name of the source type.

Load from File Select to load a source document defining the source type.

3. Define the parameters for a new resource type. Select the implementation type from the available
options.

Assertion Editor
Appendix A: Dialog Box Reference

Cloud Assessment (1.01) Page 39 of 54



Screenshot: Define New Implementation: Implementation Type

Run Configurations Dialog
Define parameters to test the assertion before publishing.
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Screenshot: Run Configurations

Parameter Definition

Name The name you want to use for the test.

Assertion Browse for and select the assertion you want to test.

Source Add or remove a document to test against the assertion.

Parameters Enter the required parameters for the selected source.
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Appendix B: Assertion Document Details
“UDDI BE 01 Assertion XMLDocument” is the raw XML document of the UDDI BE 01 assertion.

UDDI BE 01 Assertion XML Document

<?xml version="1.0" encoding="UTF-8"?>
<pm:Assertion xmlns:pm="http://systinet.com/2005/10/soa/policy"

xmlns:up="http://systinet.com/2005/10/soa/policy/uddi"
xmlns:xs="http://www.w3.org/2001/XMLSchema">

<pm:Parameter Name="lang" Type="xs:string" XPointer="xpointer(@RequiredLang)"/>
<!-- template of the instance of the assertion -->

<pm:Template>
<up:UDDI_BE_01 RequiredLang="en"/>

</pm:Template>
<pm:Validation SourceType="xmlns(ns=urn:uddi-org:api_v2)qname(ns:businessEntity)"

xmlns:uddi="urn:uddi-org:api_v2"
xmlns:val="http://systinet.com/2005/10/soa/policy/validation">

<!-- the validation is implemented via xpath expression -->
<val:XPath>

count(/uddi:businessEntity/uddi:name[@xml:lang=$lang])&gt;0
</val:XPath>

</pm:Validation>
</pm:Assertion>

Assertion documents contain the following elements:

l pm:Assertion/pm:TemplateThis required element must contain exactly one child element, which is a
reference template of how this assertion looks as aWS-Policy document. If there are namespace
definitions here, they are included in the reference template. If the assertion has any parameters, you can
define default values for them in the reference template. If there are no namespaces or parameters, the
reference template can be in the form <name/>.

l pm:Assertion/pm:ParameterAn assertion in aWS-Policy document may contain parameters including
timeouts (inWS-ReliableMessaging), type of authentication, required SOAP header elements, etc. This
element gives a definition of such parameters, including the type of the parameter and where the parameter
can be found in an instance of the assertion. This information is used both by the UI console and by policy
validators.

l pm:Assertion/pm:Parameter/@NameThe name of the parameter. This namewill be shown in the UI.
l pm:Assertion/pm:Parameter/@TypeType of the parameter's value.
l pm:Assertion/pm:Parameter/@TaxonomyA taxonomy with values that the parameter can adopt. The
taxonomy is specified using its tModelKey. This attribute is only required when Type has the pm:taxonomy
value (with pm being the xmlns:pm="http://systinet.com/2005/10/soa/policy namespace),
otherwise it is ignored (and optional).

l pm:Assertion/pm:Parameter/@XPointerIn the absence of a ValueXPointer attribute, this attribute
identifies the place of the parameter in the assertion's template (that is, how the attribute can be obtained
from an instance of the assertion). Only a simplified form of the XPointer can be used.
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The evaluation context for the XPointer is the root of the actual assertion. So, for example, b[1] is
the first "b" child of the assertion's element.
In this release, an XPath starting with "/" is interpreted to point to the root of the policy document.
This behavior will be changed, so do not use absolute XPaths.

l pm:Assertion/pm:Parameter/@ValueXPointer ValueXPointer identifies the place of the
parameter relative to the place identified by the XPointer attribute. When the parameter is not set,
the element referenced by the XPointer attribute is removed from the instance. When the parameter
is defined, its value is set to a place identified by the concatenation of the XPointer and
ValueXPointer values. The rationale for this attribute is that there are assertions whose schema
requires that either an attribute is set or the attribute's parent element is missing.

l pm:Assertion/pm:Parameter/@OptionalThis attribute tells whether the parameter is optional, that
is, if it can be omitted from the assertion instance.

l pm:Assertion/pm:ValidationThe implementation, as described in Implementations, on page 47.
The key components of the assertion, visible in both the UI and the XML document, are described in
the following sections:

l Reference Templates, below
l Parameters, on the next page
l Implementations, on page 47, which includes the validation handler.

Reference Templates
The reference template defines what the assertion looks like instantiated as aWS-Policy document
(See the generic <pm:Template> element shown in “UDDI BE 01 Assertion XMLDocument”.). If there
is a namespace to be defined it is included in the reference template. If there are parameters, you can
define the default values they point to. If there is no namespace or parameter, the template can be a
simple empty tag, like <assertionName/>.

The UDDI BE 01 assertion reference template defines the up namespace. The assertion has one
parameter, lang, which points to the RequiredLang attribute. The reference template sets the default
value of this parameter, en. The actual XML of the reference template is:

<p:Template>
<up:UDDI_BE_01 RequiredLang="en"

xmlns:up="http://systinet.com/2005/10/soa/policy/uddi"/>
</p:Template>

Reference templates must obey the following rules:

l The template namemust be unique.
l The templatemust be a complete and valid XML element, not a fragment.
l The template can carry a namespace. This is the case with theWS-I BasicProfile assertion
reference templates, such as <wsi:BP1004 xmlns:wsi="http://www.ws-
i.org/testing/2004/07/assertions/"/>
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Parameters
Parameters represent requirements whose specific values may vary. They include such things as
timeouts, type of authentication, required SOAP header elements, and so on. The value referenced by
a parameter can differ between technical policies containing the parameter's parent assertion because
each technical policy contains its own instance of the assertion.

Using parameters lets the policy developer reuse assertions. The developer can set a different required
value for an assertion in each policy in which the assertion is used. Without parameters, the developer
would need a separate assertion for each required value.

“AssertionWith Parameter” is an assertion taken from a policy file (namespaces omitted for brevity).
Note the attribute RequiredLang with the value of "en". This attribute represents the RequiredLang
parameter. Its default value is "en" for English. This default value is specified in the reference template
(see Reference Templates, on the previous page) but the policy developer can change this value in
individual policy files. If the assertion developer does not specify the parameter's default value in the
reference template and does not set the parameter as optional, the policy developer must set the
parameter value when creating a technical policy with the parameter's parent assertion.

Assertion With Parameter

<wsp:Policy xmlns:wsp="..."/>
<up:UDDI_BE_01 RequiredLang="en" xmlns:up="..."/>

</wsp:Policy>

A parameter definition has the following structure:

l pm:Parameter/@Name

Name of the parameter.
l pm:Parameter/pm:Description

Description of the parameter.
l pm:Parameter/@XPointer

Location of themodified attribute (expressed as an XPointer).
l pm:Parameter/@ValueXPointer

Location of themodified attribute (expressed as an XPointer). See below for details.
l pm:Parameter/@Optional

Optionality of the parameter (if it is optional, it might be left unfilled).
l pm:Parameter/@Type

Type of the parameter's value. Supported values aremost of built-inW3C Schema data types (see
http://www.w3.org/TR/xmlschema-2/#built-in-datatypes):
o xs:string
o xs:boolean
o xs:float
o xs:double
o xs:duration
o xs:dateTime
o xs:time
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o xs:date
o xs:gYearMonth
o xs:gYear
o xs:gMonthDay
o xs:gDay
o xs:gMonth
o xs:hexBinary
o xs:base64Binary
o xs:anyURI
o xs:QName
o xs:integer
o xs:long
o xs:short
o xs:byte
o xs:unsignedLong
o xs:unsignedInt
o xs:unsignedShort
o xs:unsignedByte
Where xs is the xmlns:xs="http://www.w3.org/2001/XMLSchema" namespace.
Also supported is the value pm:taxonomy (with pm being the
xmlns:pm="http://systinet.com/2005/10/soa/policy namespace), which specifies that the
parameter will take on values from the taxonomy specified by the@Taxonomy attribute.

l pm:Parameter/@Taxonomy

Taxonomy whose values the parameter adopts. Specified with the taxonomy tModelKey. The
attribute is required only when Type has the pm:taxonomy value, otherwise it is be ignored (and
optional). Actual parameter values are specified with keyValues in policy documents.

The following examples demonstrate the use of a taxonomy-based parameter and the corresponding
policy document:

Parameter with Taxonomy Type

<pm:Parameter Name="artifactType" Optional="true" Type="pm:taxonomy"
Taxonomy="uddi:systinet.com:soa:model:taxonomies:artifactTypes"
XPointer="xpointer(@artifactType)"
xmlns:pm="http://systinet.com/2005/10/soa/policy">

<pm:Description>Artifact type to restrict applicability.</pm:Description>
</pm:Parameter>

Policy Document with a Taxonomy-Based Assertion

<wsp:Policy xmlns:ws="...">
<up:MyAssertion

artifactType="urn:com:systinet:soa:model:artifacts:soa:applicationArtifact"
xmlns:up="..."/>

</wsp:Policy>
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The following assertion checks whether communication settings contain a connection timeout set to at
least 10 seconds. Additionally, the XMLSchema of this assertion specifies that either the "value" must
be present, or, to use the default value, the whole up:ConnectionTimeout element must bemissing.

<wsp:Policy xmlns:wsp="..."/>
<up:Communication xmlns:up="...">

<up:ConnectionTimeout value="10000"/>
...

</up:Communication>
</wsp:Policy>

In this case, a single XPointer referencing the up:ConnectionTimeout/@value attribute is not enough,
because Policy Manager would not know that the whole element should be removed when the value is
not entered. Therefore the parameter is now described in two XPaths:

l Location of the element that should be removed when the value of the parameter is not set
l Location of the value within the element defined above
The location of the element is set in the XPointer and the location of the value within the element is set
in a ValueXPointer. For example, “Parameter with ValueXPointer Set at 5000”is a parameter with the
ValueXPointer set at 5000. This results in the policy document in “Policy Document with ValueXPointer
in Parameter Set to 5000”. By contrast, if the developer leaves the ValueXPointer blank, the resulting
policy document is “Policy Document with Empty ValueXPointer in Parameter”.

Parameter with ValueXPointer Set at 5000

<p:Parameter Name="ConnectionTimeout" Optional="false" Type="xsd:integer"
XPointer="xmlns(up=...)xpointer(up:ConnectionTimeout)"
ValueXPointer="xpointer(@value)"
xmlns:xsd="http://www.w3.org/2001/XMLSchema">

<p:Description>Connection timeout in milliseconds.</p:Description>
</p:Parameter>

Policy Document with ValueXPointer in Parameter Set to 5000

<wsp:Policy xmlns:wsp="..."/>
<up:Communication xmlns:up="...">

<up:ConnectionTimeout value="5000"/>
</up:Communication>

</wsp:Policy>

Policy Document with Empty ValueXPointer in Parameter

<wsp:Policy xmlns:wsp="..."/>
<up:Communication xmlns:up="...">
</up:Communication>

</wsp:Policy>

Table “XPointer Combinations and Results” shows the XML representations of various XPointer and
ValueXPointer combinations, for optional and required attributes, and whether the value is defined or
not. “XPointer” is a correctly defined XPointer.

Note:Only a simplified form of XPointer is recognized in the parameter definition. The rationale is that
in this context XPointer is used not only for retrieving data, but also for creating parameters via the UI.
This is not possible with general XPointers. The recognized XPointer must have the following structure:
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xmlns(prefix1=ns1)*xpointer({/{<prefix>:}?<localname>[<index>]}*)

XPointer Combinations and Results

Optional Value XPointer ValueXPointer Result in Policy Schema

Yes/No 'ABC' @P — <aP="ABC"/>

Yes — @P — <a/>

No — Prohibited

Yes 'ABC' b[1] @P <a><b P='ABC'/></a>

Yes — b[1] @P <a/> (XPointer is removed.)

Yes 'ABC' b[1] — <a><b>ABC</b></a>

Yes 'ABC' b[1] c[1] <a><b><c>ABC</c></b></a>

Yes — b[1] c[1] <a/> (XPointer is removed.)

XPointer

xmlns(soap=http://schemas.xmlsoap.org/soap/envelope/)
xmlns(myns=http://systinet.com/examples/foo)xpointer(soap:Envelope[1]/soap:Body[1]
/myns:Foo)

Implementations
An assertion has one implementation for each source type to which the assertion applies. Each
implementation is propagated into its own pm:Validation element. An implementation contains the
definition of the validation handler, in p:Validation/##other[1], and the type of artifact which the
assertion can be used to validate, in p:Validation/@SourceType.

Implementations use validation handlers if they do not specify manual validation. Validation handlers
are pluggable pieces of code that show Policy Manager how to validate a source document. Validation
handlers are usually XPath, JavaScript or XQuery expressions, in which case the source code is
included inside the implementation, but they can be custommade. Custommade validation handlers
are written in Java and the implementation references the Java class.

Validation handlers and source types are described in the following sections:

l Source Type, on the next page
A description of all source types to which an implementationmay apply.

l XPath Assertions, on page 49
XPath validation handlers.

l XQuery Assertions, on page 50
XQuery validation handlers.

l JavaScript Validator Assertions, on page 51
JavaScript validation handlers.
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Source Type
The pm:Validation@SourceType attribute defines the type of artifact validated by the assertion.
SourceTypemust be a simplified XPointer identifying the root element of the resource which the
assertion validates. If this parameter is omitted, the implementation would apply to sources of any
type. However, for performance reasons it is better to map validation to a concrete source type, as
narrowly as possible.

SourceType can be set as one of the following:

l A general artifact type with the namespace usually defined in the pm:Validation element. Please
see Table “Source Types Applying to General Resources” for a list of these SourceType values and
their associated artifacts and namespaces.

l An artifact type. These share the namespace
xmlns:a="http://systinet.com/2005/05/soa/model/artifact". A list of these SourceType
values and their matching artifact types will follow this structure:
xmlns(ns=http://systinet.com/2005/05/soa/model/artifact)qname(ns:[artifactType])

For example, xmlns (ns=http://systinet.com/2005/05/soa/model/artifact)qname (ns :
applicationComponentArtifact)

Source Types Applying to General Resources

Resource SourceType value

Any resource xmlns(ns=http://systinet.com/2005/05/soa/resource)qname(ns:resource)

SOAP message xmlns(ns=http://schemas.xmlsoap.org/soap/envelope/)qname
(ns:Envelope)

UDDI v3 Business
Entity

xmlns(ns=urn:uddi-org:api_v3)qname(ns:businessEntity)

HTTP Message
Document

xmlns(ns=http://systinet.com/2005/10/soa/policy/report)qname
(ns:Message)

WSDLDefinition xmlns(wsdl=http://schemas.xmlsoap.org/wsdl/)wsdl:definitions

XML Schema xmlns(xsd=http://www.w3.org/2001/XMLSchema)xsd:schema

Conversation
Document

xmlns(ns=http://systinet.com/2005/10/soa/policy/report)qname
(ns:Conversation)

Source Types Applying Artifacts

Artifact Type SourceType Value

Application
Component

xmlns(a=http://systinet.com/2005/05/soa/model/artifact)
applicationComponentArtifact

Business Service xmlns(a=http://systinet.com/2005/05/soa/model/artifact)
businessServiceArtifact

Contact xmlns(a=http://systinet.com/2005/05/soa/model/artifact)contactArtifact
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Artifact Type SourceType Value

Documentation xmlns(a=http://systinet.com/2005/05/soa/model/artifact)
documentationArtifact

Person xmlns(a=http://systinet.com/2005/05/soa/model/artifact)personArtifact

Policy xmlns(a=http://systinet.com/2005/05/soa/model/artifact)policyArtifact

Report xmlns(a=http://systinet.com/2005/05/soa/model/artifact)reportArtifact

SOAP Service xmlns(a=http://systinet.com/2005/05/soa/model/artifact)webServiceArtifact

Schema xmlns(a=http://systinet.com/2005/05/soa/model/artifact)schemaArtifact

Taxonomy xmlns(a=http://systinet.com/2005/05/soa/model/artifact)taxonomyArtifact

WSDL xmlns(a=http://systinet.com/2005/05/soa/model/artifact)wsdlArtifact

Web Application xmlns(a=http://systinet.com/2005/05/soa/model/artifact)webArtifact

XSLT xmlns(a=http://systinet.com/2005/05/soa/model/artifact)xsltArtifact

XPath Assertions
Example “XPath Expression” is an XPath that applies to UDDI business entities and returns every
name element whose langattribute is set to the same value as the value of the lang parameter. If the
XPath returns a non-empty list, the source document is considered to be valid against the assertion. If
the returned node list is empty, validation has failed.

XPath Expression

<val:XPath>
count(/uddi:businessEntity/uddi:name[@xml:lang=$lang])&gt;0

</val:XPath>

Youmust take the following points into account when writing XPath assertions:

l Namespace
The element val:XPath is the namespace context for the XPath expression. If you need to define a
prefix-namespacemapping, do it on this element or its ancestors.

l Type system
The XPath engine used in this enforcer is the free version of the Saxon-B 8.5.1 XSLT/XPath/XQuery
engine. Although this version does not contain XML Schema parsing, it still checks for type
conformance. For example, if you need to check that the value of attribute "xyz" is greater than 5,
include in your XPath expression:

xs:integer(@xyz) > 5

If you fail to retype to integer, the XPath expression will never be fulfilled and no warning will be
returned.

l Parameter type
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In this release, assertion parameters are always passed as strings, regardless of the schema type
written in the parameter definition. For this reason you have to explicitly cast the parameter in
numerical comparisons. For example, the following XPath expression would be used in an assertion
which checks that themessage's body has at most a given number of elements (defined as a
parameter namedMaxElements):

count(soap:Body//*) <=xs:integer($MaxElements)

XQuery Assertions
XQuery expression can be represented as follows:

XQuery Expression

<val:XQuery>
declare namespace rest="http://systinet.com/2005/05/soa/resource";
declare namespace a="http://systinet.com/2005/05/soa/model/artifact";
declare namespace p="http://systinet.com/2005/05/soa/model/property";
declare namespace val="http://systinet.com/2005/10/soa/policy/validation";
declare variable $metadata.source.url external;
if (exists

(rest:resource/rest:descriptor/a:businessServiceArtifact/p:productionStage)) then
val:assertionOK()

else
val:assertionFailed(concat('This service is not assigned a category from a

lifecycle taxonomy. ',
'To fix this problem, go to <a href="', $metadata.source.url, '&view">the

service</a>, ',
'click on "Edit" and assign the category.'))

</val:XQuery>

The XQuery in “XQuery Expression” comes from the Service Supports Lifecycle assertion. The XQuery
applies to business services and checks that each service has a lifecycle stage assigned to it. In the
Cloud Assessment 2 use of XQueries, the assertionOK function is called only one time per tested
artifact if the artifact passes validation, whereas if the artifact fails, the assertionFailed function is
called for each individual violation. For the XQuery in “XQuery Expression” there is no logical need to
call assertionFailedmore than once, since the artifact either has one lifecycle stage or none at all. In
“XQuery ReportingMultiple Failures”, the XQuery checks each include and import element and
makes sure they use relative references. The assertionFailed function is called for each element
that does not use relative references.

XQuery Reporting Multiple Failures

declare namespace xs = &quot;http://www.w3.org/2001/XMLSchema&quot;;
declare namespace

val=&quot;http://systinet.com/2005/10/soa/policy/validation&quot;;
let $errors :=
for $el in //xs:*[local-name() = 'include' or local-name() = 'import'] where

($el/@schemaLocation and contains($el/@schemaLocation, ':'))
return
val:assertionFailed(concat('This xs:', local-name($el), ' uses absolute
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reference to another schema.'), $el)
return
if (empty($errors)) then

val:assertionOK()
else

()

NOTE:
Namespaces are not propagated from parent elements but defined via standard XQuery
declarations.

Together with the source document, XQuery assertions can be called with additional parameters. For
example, these parameters can be used by the assertion to perform additional checks or output the
location of the problem back to the user. The parameters are added to the XQuery expression of the
assertion. A metadata parameter is shown in “XQuery Expression”.

Parameter name Description

metadata.source.url The URL of the source of validation. In the case of HTTP
request/response, this points to the request/responsemessage.
For one-way messages, WSDL documents etc. it points to the
resource being validated.

metadata.description.url The URL of the associated description document (for example,
WSDL associated to a log of messages).

metadata.source.is.subdocument Detects subdocuments. Returns "false" if document is
standalone, "true" if document is part of a larger document.

If you want to write a new XQuery assertion or modify an existing one, follow these guidelines:

l The XQuery engine used in this enforcer is the free version of the Saxon-B 8.5.1
XSLT/XPath/XQuery engine. Although this version does not contain XML Schema parsing, it still
checks for type conformance. For example, if you need to check that the value of attribute "xyz" is
greater than 5, write:

xs:integer(@xyz) > 5

Failing to do so, the XQuery expressionmight never be fulfilled. If this happens, no warning will be
returned.

l In this release, assertion parameters are always passed as strings, regardless of the schema type
written in the parameter definition. Because of this youmust explicitly cast the parameter in
numerical comparisons. For example, the following expression would be used in an assertion which
checks that themessage's body has at most a given number of elements (defined as a parameter
named MaxElements):

count(soap:Body//*) <= xs:integer($MaxElements)

JavaScript Validator Assertions
JavaScript Validator expression can be represented as follows:

JavaScript Validator Expression
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/**
* This function is called iteratively by the java script validator,
* There are some java script objects pre-initialized in the scripting context

(e.g. repositoryService ...)
* You can find others and configure more in the managed script environment.js
* @param resource
* an external resource or an artifact
* @param params
* a map of params
*/

function validate(resource, params) {
return new JsValidationResult(JsValidationCode.OK);
}

Towrite a JavaScript Validator assertion, seeMicro Focus Cloud Assessment Java Client API Java
documentation.
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Appendix C: Integrating XQuery Function
Libraries
You can integrate a user-defined XQuery Library into Assertion Editor.

To Integrate an XQuery Function Library:

1. You JAR file must have the following structure:
l your-lib.jar

o META-INF
n your-XQueryContext.xml

o com
n your-class

your-XQueryContext.xml shouldmatch the following structure:

<?xml version="1.0" encoding="UTF-8"?>
<beans xmlns="http://www.springframework.org/schema/beans"

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:aop="http://www.springframework.org/schema/aop"
xmlns:jee="http://www.springframework.org/schema/jee"
xmlns:lang="http://www.springframework.org/schema/lang"
xmlns:tx="http://www.springframework.org/schema/tx"
xmlns:util="http://www.springframework.org/schema/util"
xmlns:context="http://www.springframework.org/schema/context"
xsi:schemaLocation="http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans.xsd
http://www.springframework.org/schema/aop
http://www.springframework.org/schema/aop/spring-aop.xsd
http://www.springframework.org/schema/jee
http://www.springframework.org/schema/jee/spring-jee.xsd
http://www.springframework.org/schema/lang
http://www.springframework.org/schema/lang/spring-lang.xsd
http://www.springframework.org/schema/tx
http://www.springframework.org/schema/tx/spring-tx.xsd
http://www.springframework.org/schema/util
http://www.springframework.org/schema/util/spring-util.xsd
http://www.springframework.org/schema/context
http://www.springframework.org/schema/context/spring-context.xsd">
<context:annotation-config/>
<!--STM Lifecycle Policies: XQuery extension for Policy Manager,

depends on lifecycle API-->
<bean id="your-bean-id" class="your-class-XQueryExtension" scope="singleton"/>

</beans>

2. Open AE_LIB/META-INF/eclipseBeanRefContext.xml in a text editor.
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NOTE:
AE_LIB refers to WB_HOME/plugins/com.em.tools.assertioneditor.lib_1.0.n.xxx
for standalone version or WB_
HOME/dropins/sw/eclipse/plugins/com.hp.em.tools.ae.lib_1.0.n.xxx
for the plugin version.

3. Add your mapping file to the constructor-arg element:

<beans xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:schemaLocation="http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans.xsd">

<bean id="com.hp.soa.em"
class="com.hp.em.spring.ClassPathXmlApplicationContext">

<constructor-arg>
<list>

<value>classpath*:META-INF/${mapping_file.xml}</value>
<value>classpath*:META-INF/pmContext.xml</value>
<value>classpath*:stmContext.xml</value>

</list>
</constructor-arg>

</bean>
</beans>

4. Add the XQuery library to the AE_LIB/lib/ folder.
5. Modify AE_LIB/META-INF/MANIFEST.MF to set the Eclipse classpath. Add the XQuery library to

the Bundle-ClassPath item. For example, lib/lifecycle-xquery.jar.
6. Restart Micro Focus Cloud Assessment Workbench with command, start.exe -clean.
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